Access 2003 Reports

Support Services
Office of Information Technology, West Virginia University

OIT Help Desk – 293-4444 x 1

oit.wvu.edu/support/training/classmat/db/

Instructor: Kathy Fletcher
Last revised: February 21, 2005

Copyright 2003 West Virginia University
### Table of Contents

**Course Description** ................................................................. 1

**Report Basics** ........................................................................ 2
  - Why use reports? ................................................................. 2
  - Report Views ..................................................................... 2

**Creating Reports** .................................................................... 3
  - Design View ....................................................................... 3
  - Creating a Report from Scratch .......................................... 3
  - Wizards .............................................................................. 3
    - Activity 1: Interactive Report Wizard ............................. 4

**Modifying Reports Appearance** ............................................. 5
  - Control Properties ............................................................ 5
  - Formatting Controls ........................................................... 5
  - Sections ............................................................................ 6
    - Activity 2: Create a Cover Page for the report ................ 8
    - Activity 3: Make each Company print on separate pages ... 8

**Adding Controls to Reports** .................................................. 9
  - Activity 4: Add additional fields to the Report ................... 10

**Mailing Labels** ....................................................................... 11
  - Activity 5: Create mailing Labels ....................................... 11

**Create Controls That Grow with a Report's Data** .................. 12

**Apply Conditional Formatting to a Report Control** .............. 12

**Make Reports Easier to Read with Alternate Line Shading** .... 13

**Stop Empty Reports** .............................................................. 14
Course Description

This is the third in a series of six classes about Microsoft Access 2003. It deals specifically with report design.

The purpose of this installment is to introduce you to the creation of reports. Designing reports can be time consuming and requires some patience. Learning the tools and methods that are available is the first step to creating effective reports.

Our goal is to assist you to learn the software, understand some basic concepts and show you some tips and techniques so you can develop your database management and programming skills over time.

The Microsoft Access series includes six sequential workshops:

- Introduction to Access
- Access Queries
- Access Reports
- Access Database Design
- Access Form Design
- Access Macros
Report Basics

Why use reports?

A Report is an effective way to present your data in a printed format. Because you have control over the size and appearance of everything on a report, you can display the information the way you want to see it.

You can create reports that will:

- Organize and present data in groups
- Calculate running totals, group totals, grand totals, and percentages
- Include subforms, subreports, and graphs
- Create mailing labels
- Combine data from multiple tables and/or queries
- Present the data in an attractive format with fonts, lines, and pictures

Report Views

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design View</td>
<td>In Design View, you can create and modify the report appearance.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>In Print Preview, you can verify the actual data by reviewing every page in the report.</td>
</tr>
<tr>
<td>Layout Preview</td>
<td>In Layout Preview, you can take a quick look at the layout, which includes just a sample of the data in the report. It does not show the actual data in the report.</td>
</tr>
</tbody>
</table>
Creating Reports

**Design View**
Creating reports in design view requires that the creator add each item to the report one by one. This is a long and tedious process.

**Creating a Report from Scratch**
- Click on the **Reports** object, then click on the **New** button.
- Select the table or query that is to serve as the basis for the report.
- Select the **Design View** option and click on **OK**.
- Design the report using the Control Toolbox buttons. These tools are covered in detail in the *Access Form Design* workshop.

**Wizards**
Report wizards are available to assist the user during the report creation process. Even experienced users will find the wizards a quick and easy way to create a basic report that can be modified to meet some particular specifications.

- **Report Wizard:**
  The Report Wizard is the most common way to create reports. The user is prompted with a series of questions and a report is created based on the answers. The report can then be customized in design view.

- **AutoReport Wizard (Columnar/Tabular):**
  The fastest way to create a report is with one of the AutoReport Wizards. These wizards produce columnar or tabular reports automatically without prompting you for information.

- **Chart Wizard:**
  The Charts Wizard converts numerical data into meaningful graphs similar to the charts created in Excel.

- **Label Wizard:**
  The Label Wizard produces labels for many different brands of labels based on select fields. You can also create labels for customized label sizes.
Activity 1: Interactive Report Wizard

1. Open Northwind database.
2. Click on the Reports object.
3. Click on New.
5. Choose the Order Info Sorted by Company query from the list.
6. Click on OK.
7. Add all fields except Quantity to the report.
8. Click on Next.
9. Select by Customers.
10. Click on Next. (Do not specify grouping levels)
11. Click on Next. (Do not specify grouping levels)
12. Select ProductName to sort by; choose ascending or descending by clicking on the button to the right of the text box.
13. Click on Next.
15. Click on Next.
16. Select a style.
17. Click on Next.
18. Give the report the title Order Report.
19. Click on Finish.
20. Close the report, save changes if prompted.
Modifying Reports Appearance

Report layout and appearance must be changed in design view after the report is initially created. To modify an existing report:
1. Click on the Reports object.
2. Select the Order Report.
3. Click on the Design button.

Control Properties
You can view all of the options for a control or a section within the properties window. Click on the properties button on the toolbar or choose View | Properties from the menus to display this window.

Formatting Controls

Cut, Copy, and Paste:
These functions work the same as they do in other Microsoft software.

Move:
Controls on a report can be moved by selecting the control and dragging it to the new location. If a control is already selected, you can move the control when the cursor changes to a hand.

Re-Size:
Controls on a report can be resized by selecting the control and then positioning the cursor over one the black boxes surrounding the control. Once you have a double arrow, click and drag to change the size.
Colors:
The foreground and background color of each control can be changed by
1. Click on the control to select it
2. Right click and select **Font/Fore** or **Fill/Back**
3. Choose one of the colors displayed

or

4. Click on the control to select it
5. Open the **Properties** window
6. Click on the **Format Tab**
7. Click in the text box for **Back Color** or **Fill Color**
8. Click on the ellipse (…)
9. Choose a color from here or click on **Define Custom Color** and define your own
10. Click on **OK**

Formatting multiple controls at once
Any changes will be applied to all selected controls
1. Click on the first control
2. Hold down the **Shift** key on the keyboard
3. Click on all other controls that you wish to change

Sections
 Headers and Footers
The headers and footers for each section can be turned on and off. Report and page headers and footers are displayed or hidden together, but section headers and footers can be turned on and off individually.

To change the section headers and footers:
1. Click on the square outline in the upper left corner of the report. A solid black square should be displayed.
2. Right click on the square and choose **Sorting and Grouping**
3. Change the **Yes/No** option for **Group Header** and **Group Footer** for each item in the list to **Yes**.

For the report header and footer choose **View | Report Header/Footer** or **View | Page Header/Footer**.
Re-Sizing

Report sections can be resized by hovering the mouse along the lower border of the section and dragging the lower border up or down. The cursor should change to a double arrow when in the correct location.

Inserting Images

Images can be inserted into any report section. Most image formats are acceptable.

1. Click on the Image tool.
2. Click and drag to create a box in the report where you want the image to be placed.
3. Browse to the image that you want to insert.
4. Click on OK.
5. Resize the image area to fit the image.

To keep images in proportion change the size mode to zoom:

Select the image, open the properties and click on Size Mode then choose Zoom from the list.

Lines/Shapes

Lines and shapes can also be inserted into any report section. Lines are commonly used to separate data and shapes are generally used to provide borders for groups of data or sections within the report.

To insert a straight line:
1. Click on the Line tool.
2. Click and hold to draw the line where you want the line to be placed.

Note: For a straight line, hold the SHIFT key down while you draw the line.

Page Break

Page breaks can be inserted to force the data to fall on separate pages.
1. Click on the Page Break tool.
2. Click the spot where you want the page break to be placed.
**Activity 2: Create a Cover Page for the report**

1. Select the **Order Report**.
2. Click on **Design**.
3. Increase the size of the report header section.
4. Insert the `logo.gif` picture into the report header section.
5. Change the size of the image.
6. Change the title of the report to **Order Report by Company**.
7. Change the background and foreground color of the title.
8. Change the font size and color of the title.
9. Move the title label to another location within the section.
10. Insert a page break at the bottom of the report header.
11. Save the changes to the report.
12. Save the report and switch to **Print Preview** to view the changes.

**Activity 3: Make each Company print on separate pages**

1. Select the **Order Report**.
2. Click on **Design**.
3. Display the Footer for the **CompanyName** section (if it is not already showing).
4. Insert a line in the **CompanyName** footer section.
5. Change the border width of the line to **2pt**.
6. Change the color of the line.
7. Insert a page break in the **CompanyName** footer, below the line.
8. Save the report and switch to **Print Preview** to view the changes.
Adding Controls to Reports

Labels

Labels can be used to put titles, headings, and other information onto a report that will not change. Click on the label tool and then draw the text box on the report in the desired location.

Textboxes

Textboxes are used when you want to insert data onto a report that is pulled from a table or query or is calculated with a function. Click on the textbox tool and then draw the text box on the report in the desired location. A label is automatically inserted with each textbox.

View Field List

The field list shows a list of the available fields that can be added quickly to the report. If a field is not listed here, it does not mean that it cannot be added to the report.

- Choose View | Field List from the menus
- Click on the Field List button on the toolbar

Add Fields to Report

Using the field list, additional fields can be added by clicking on the field that you want to add and dragging it to the desired location in the report.
**Activity 4: Add additional fields to the Report**

1. Select the **Order Report**
2. Click on **Design**
3. Add the **Quantity** field to the report
4. Adjust the size and location of the other labels and text boxes fit Quantity to the right of Unit Price
5. Format the added label and text box to match the existing report controls
6. In the **Report Header** section, insert a textbox
7. Open the **Properties** window
8. Click on the **Data** tab
9. Enter `=Date()` into the **Control Source** textbox
10. Click on the **Format** tab
11. Choose **Long Date** for the format
12. Change the font size, color, and any other properties
13. Switch to **Print Preview** to see the changes
14. Save changes and close the report
Mailing Labels

Activity 5: Create mailing Labels

1. Click on the Reports object.
2. Click on New.
4. Select the Customers table.
5. Click on OK.
6. Choose Avery as the Manufacturer.
7. Choose English as the Unit of Measure.
8. Choose the 5160 Product Number.
9. Click on Next.
10. Choose the font properties.
11. Click on Next.
12. Select the field that you want to add and click on >. Press Enter to move down to the next line and the space bar to enter a space. If you type text onto this label, it will appear on every label that is created.
13. Click on Next.
14. Choose PostalCode as the sort field.
15. Click on Next.
16. Enter a title for the report.
17. Click on Finish.
18. Switch to Design View.
19. Close the report. Save changes if prompted.
Create Controls That Grow with a Report's Data

When you print a report, some of the data may be missing because the text box controls aren't large enough to fit all of the data. You can readjust the size of the control, but the Can Grow property will automatically adjust the size.

To take advantage of the Can Grow property, follow these steps:

1. Open the Customers report.
2. In Design view, select the text control you want to resize.
3. In the Properties dialog box click the Format tab, click Can Grow, and select Yes from the drop-down list.

When you run the report, the control will automatically expand to accommodate additional lines of data when the data is larger than the control.

Data that's too short for the defined size of a text control will cause Access to print blank lines. To have the control automatically resize to eliminate blank lines, follow the same steps for the Can Shrink property.

Apply Conditional Formatting to a Report Control

You can configure conditional formatting to automatically highlight areas of your report when it meets certain conditions. For example, let's say you want Access to display all orders with a Quantity of 20 or above in blue numbers on a yellow background in your Order Report.

Follow these steps:

1. Open the Order Report in Design View.
2. Select the Quantity text control box.
3. From the menu bar go to Format | Conditional Formatting.
4. Under Condition 1, select Greater Than Or Equal To from the second drop-down list.
5. Enter 20 in the text box.
6. Select yellow from the Fill/Back Color drop-down box.
7. Select blue from the Font/Fore Color drop-down box. Click OK.

When you run the report, Access will format all fields that have a quantity of 20 or above with blue numbers on a yellow background as you’ve indicated.
Make Reports Easier to Read with Alternate Line Shading

Reports that list a lot of records with many columns of data can be difficult to follow. However, you can make these reports easier to read by adding alternate line shading.

Follow these steps:

1. Open the **Northwind** database. Open **Customers Report** in Design View.
2. Double-click the **Detail** Section Selector. (This is the box on the ruler to the left of the Detail section divider.)
3. On the Event tab, select **[Event Procedure]** from the **On Format** drop-down list.
4. Click the gray box with ellipsis (…) to launch the Visual Basic Editor.
5. Enter the following:

   ```vb
   Const vbLightGrey = 12632256
   If Me.CurrentRecord Mod 2 = 0 Then
       Me.Section(acDetail).BackColor = vbLightGrey
   Else
       Me.Section(acDetail).BackColor = vbWhite
   End If
   ```

6. Close the Visual Basic Editor window and save your report.

When you run the form, Access will use a white background color for odd records and a light gray background color for even records. Please note that the background color of any text boxes in the record will remain the same.
Stop Empty Reports

If there's one thing that drives Access users crazy, it's running a report that contains no data. Whether the empty report goes to the screen or directly to the printer, it wastes time. Fortunately, as long as the report is bound to a table or query, there's a quick and relatively painless way to tell Access not to bother running a report if it contains no data.

Here's how it works:

1. Open a report in **Design View**.

2. In the **Properties** dialog box, click the **Event** tab.

3. Click the **On No Data** property, choose [**Event Procedure**] from the drop-down list, and click the gray box with an ellipsis (\...) to launch the Visual Basic Editor.

4. Access will enter the first and last lines of the subroutine for you. To inform the user what's going on, enter two commands:

   ```vba
   MsgBox ("Sorry--this report contains no data. Canceling...")
   Cancel = -1
   
   The final subroutine should look like this:
   
   ```vba
   Private Sub Report_NoData(Cancel As Integer)
   MsgBox ("Sorry--this report contains no data. Canceling...")
   Cancel = -1
   End Sub
   ```

Customize the message you display based on the type of report and the end user who will be running it.

Save and close the Visual Basic editor. Save the report, and the next time the report is run without data, the message box will appear instead of an empty report screen.